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Introduction
Welcome to the training manual “Produce basic
spreadsheets”

The purpose of this manual is to give you the knowledge and skills
to produce a basic spreadsheet or workbook.

This will include understanding the layout of a spreadsheet file, called
a workbook, and key terminology related to this.   You will learn how
to enter data, how to enter and calculate formulas, and how to edit
both data and formulas.  You will learn how to save your work for
retrieving it later, and how to make changes.  You will also learn how
to format your workbook so that it looks professional and is easy to
read, including when it is printed.  In addition, you will become familiar
with the Help function to assist you in finding answers on how to do
things not covered in this manual.

What is in this manual?
This training manual is divided into 5 sections:

Section 1 Produce a basic spreadsheet

Section 2 Retrieve, format and edit a workbook

Section 3 Basic spreadsheet calculations

Section 4 Use the Help function

Section 5 Print a basic spreadsheet.

Each section starts with an introduction and explains the skills you
will learn. At the end of the section you will have an opportunity to
check your progress by answering some questions.

Skills you will learn:
After you have completed this manual, you will be able to:

• demonstrate the procedures for producing a basic spreadsheet

• demonstrate the procedures to retrieve, format and edit a
workbook

• outline the procedures for performing basic spreadsheet
calculations

• demonstrate the procedures for using the Help function

• outline the procedures for printing a basic spreadsheet.
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How to use this manual
Work through the manual from the beginning. You know that it is
divided into 5 sections. It is a good idea to complete a whole section
in one go if you can. At the beginning of the section you will find a list
of skills you will learn. Read these carefully and return to them when
you have completed your work. It is important that you do not move
on until you have learned all the required skills.

Read each section carefully. You may come across new words which
you do not know. These should be explained in the glossary at the
end of the manual. You will learn many new technical terms as you
progress through this manual and it is important that you learn them
all well.

At the end of each section, you will find an opportunity to ‘Check
your progress’. These questions have been carefully designed to
help you to see how well you have understood and learned the topic.
The answers are given at the end of the manual. You can choose to
look at the answers before trying to complete the question yourself -
if you want to. But the only person you will be cheating is yourself.
No-one will take in your manual and mark it for you. You yourself
must judge how well you are doing.

You will also find some practical activities. You will need to collect
the required equipment and carry out these activities. Your instructor
or supervisor will assist you.

At the end of each section, you will find a Summary. Again, you
should read it carefully to review what you have learned. It is a good
idea to check the Skills you will learn at the start of the section
again and make sure you have achieved them all. If not, you may
need to revise the section again.
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What these symbols mean

Symbols are placed in the left hand margin to draw attention to the
type of information at that point.The symbols used in this manual
are:

Read

Demonstrate/discuss -sometimes your instructor will
demonstrate or discuss the use of tools and equipment.

Check your progress - these are easy exercises to test your
understanding of the theory you have learnt. Typical correct
answers are provided at the back of the manual.

Practical activity - these activities help you to practise some
of the theory you have learnt.

Learning activity - these activities help you to relate the
knowledge and skills in the sections to your own work situation.

 Remember/Take Note

Revise

Safety/Caution/Beware
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SECTION

1

Produce a basic
spreadsheet document
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Introduction
In this section of the training manual you will learn how to produce a
basic spreadsheet document.

It includes the purpose of producing a basic spreadsheet document,
the advantages and disadvantages of using a spreadsheet
programme, and the procedures for using a basic spreadsheet
programme.

This includes entering data into cells, modifying data entered and
resizing cells to fit information entered.

Skills you will learn:
By the end of  this section, you will be able to:

• state the purpose of using a basic spreadsheet application

• state the advantages and disadvantages of using a spreadsheet
programme

• describe and apply the procedures for using a spreadsheet
programme.
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Purpose of spreadsheets
A spreadsheet is a programme that organises and keeps track of
data and is generally used for numeric calculation.  Spreadsheets
are frequently used for their ability to perform mathematical
calculations with large volumes of data, and to produce graphs and
charts with ease.  A spreadsheet file is called a workbook.

Spreadsheets are organised as grids with columns and rows in
which numbers, formulas or text can by written.  The columns are
named using letters while the rows are named by numbers.  The
intersection of a column and a row gives a cell.  A cell is named
using the column and row it belongs to called the cell reference.
Row headings are the numbers along the left of the worksheet and
the column heading are the letters along the top of the worksheet.
For example, the cell C5 refers to the cell formed by the intersection
of column C and row 5.

A spreadsheet programme has two layers.  In word processing, what
you see is what you get.  With a spreadsheet programme this is
different.  The data that you enter into the sheet is not always what
you see on screen or the printout.  For instance, you usually see the
result of a calculation, not the formula itself.

Advantages of spreadsheets
There are numerous reasons why using a spreadsheet is much better
than using a calculator or pen and paper.

• Using a spreadsheet saves time!  The spreadsheet
instantaneously performs mathematical calculations when set
up.  No more double and triple-checking calculations with a
calculator.

• It is easy to change the data and get new results.  The
spreadsheet instantly recalculates the equation for you when you
enter new numbers

• It is easy to make graphical representations of your data.  In
addition, you can present this information in different ways and
easily manipulate the data entered into the spreadsheet.

C5
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• Allows for flexible presentation.  You can alter column widths
and row heights, and easily delete or add cells, columns and
rows.  You can also control the types of numbers you enter – for
example, you can choose percentages, currency or set the
number of decimal places.

Disadvantages of spreadsheets
• Formulas can be tricky.  You must be very careful when you enter

equations or use formulas to ensure that the spreadsheet is
calculating the intended numbers and formulas correctly.

• It is not as text-friendly as word processing.  Text can be entered
(and lists even sorted alphabetically), but it is not good for
entering lengthy text, like a letter.

• The worksheet can become awkward.  As more and more data
is entered, the worksheet expands off screen, so that not all data
can be viewed at once.  This can cause problems with finding
information and navigating around the worksheet.

• Unless you have your own computer or 24-hour access to one,
you will only be able to work at limited times when you get access.
This could also cost money if you are using, for example, an
Internet café

• You will have to take time to learn how to use the spreadsheet.
For instance, sorting and filtering data are useful functions, but
they take time to learn and perfect.

• The storage device on which you save your work can be lost,
damaged or stolen.

• Printing will require a printer.
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Procedures for using spreadsheets

Starting a spreadsheet
There are various ways to start a spreadsheet.

1.  Use the Start menu.

Click on   Start    

(which you will see at the bottom left of the screen). A Start menu
appears 

Click on All Programs and drag the mouse pointer across the words
All Programs towards the right - a new menu appears to the right
of the Start menu.

Sometimes the program will be in a folder called Microsoft Office.
Click on this folder and then click on the programme.
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2. Use desktop icon

Sometimes there will be an icon directly linked to the
programme on the desktop.  Double-click on the icon
and the programme will start.

Creating a spreadsheet
Once you start the programme, your screen should look similar to
this:
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Click on the X in the upper right corner where it says ‘Getting Started’,
to close this window.  (If the ‘Getting Started’ dialog box doesn’t
appear, do not worry about this step.)  Your screen should now look
like the one shown here.

As stated previously, a spreadsheet file is called a workbook.  When
you open a new workbook, it is automatically named ‘Book1’ until
you name it otherwise.  Look at the Title Bar, the blue strip at the
very top of the workbook.

For example, if you were typing a Fractions Test and named it
“Budget 2006”, when saving it, would look like this:

The largest portion of the screen is taken up by a view of the
worksheet area; this area shows the grid made by the columns
and rows.  Worksheets are used to list and analyse data.  At the
bottom left of the screen are worksheet tabs that indicate the active
worksheet.  By default, new workbooks contain three worksheets.

The active sheet is the one that is white and appears to be ‘on top’
of the others.  To change the sheet you are working in (active sheet),
click on the tab of another sheet.
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The thick black rectangle indicates the selected cell.  Again, a cell
is the intersection of a row and a column.  The selected cell’s
reference, A1, appears in the name box.  The cell reference is
composed of the column letter followed by the row number.

To the right of the name box is the Formula bar, which is where text
and formulas are entered and edited for each cell.

The Menu bar is directly beneath the Title bar and contains various
menu options. These menus give instructions to the software.  When
you click on a word a menu is “pulled down”. This is known as a
drop-down menu.  For example if you click on “File” the File menu
will pull down as follows:
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Anytime you want to start a new workbook while the programme is
open, you can click on New in the File menu.  Also, do you notice the
little picture to the left of the word New?

This is called an icon and corresponds to a button in the Standard
toolbar.  You could also click this button to start a new spreadsheet.

The Standard toolbar is below the Menu bar, and contains buttons
that correspond to some frequently used menu commands.

The Formatting toolbar is usually located below or next to the
standard toolbar.  It contains buttons that correspond to several
commands for formatting cells.

At the bottom and right of the screen are your scroll bars, which
can be used to view parts of the worksheet that are off the screen.

Name box

Formula bar

Formatting Toolbar

Standard Toolbar

Selected Cell

Worksheet Area

Worksheet Tabs

Scrollbars
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Entering data
Cells can contain text, numerical values, formulas or functions. To
enter data into a cell, first select the cell by clicking on it.  As just
described, the cell will be identified as selected with a thick black
rectangle around it.  Once selected, you can begin typing in the cell.
The text will appear in the cell and also in the formula bar.

When the entry is complete, press Enter, Tab or use the cursor arrows
to move to a new cell.  Press Enter and the selected cell will now be
the cell below (in the same column).

Tab will move the selected cell over to the next column (in the same
row).

You can also use the cursor arrows to move around the worksheet
and select any cell you desire.

The last way to select a cell is to simply use the mouse, and point
and click in the desired cell.  In the spreadsheet, the cursor looks
like a small cross.
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Do not move to a new cell when, as you are entering data, you
cannot see the entire entry.  It is still in the selected cell – look at the
formula bar.  Once you press enter, the entire entry will appear.  If
you cannot see the entire entry, you can resize the cell, which you
will learn shortly.

When you enter text in a spreadsheet, the spreadsheet will try and
predict what you want to write by identifying some letters.  Let us
say you are making an address list.  In this example, the spreadsheet
predicts that you are going to type ‘Windhoek’ again since you did
this in cell C1.  The word will be highlighted as shown.

If this is the word you want, you can just press the Enter key without
finishing typing it yourself.  If, however, this is not the correct word
but you were really typing ‘Walvis Bay’, just continue typing as normal.
As soon as you type the ‘a’ the highlighted bit will go away (since ‘a’
is not the next letter in Windhoek and therefore is obviously not the
word you want). This function is called “auto-complete”.

Modifying entered data
There are two ways you can change or delete data in a particular
cell.

1. The first way is to simply select the cell and press the Backspace
key or the Delete key.  The entire entry of the cell will be deleted.
You can then start entering data again if you want.

2. The second way to modify cells allows you to just alter or delete
part of a cell.  First you must select the cell you want to modify.
You will see its contents in the formula bar.  Now, using the
mouse, click in the formula bar and alter the entry as you would
in a word processing document.
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Error values
If you use a spreadsheet programme, once in a while it might give
you error values that are important to know.  For instance, if you see
a row of # in a cell, you have not done anything wrong.

That means that there is simply not enough space to show the value
in the cell.  Enlarging the column (which you will learn how to do
shortly) will replace the ##### with the value.

In the table below are some of the common error messages and
what they mean.

Error value in  Error value Typical cause Example
Microsoft  in Open
Excel  Office Spreadsheet

#NAME?  Err:511 Text not recognized =1+B*2
in a formula

#VALUE! 504 or The wrong type of Text used
#VALUE! argument used in instead of a

a formula number

#NUM! #VALUE! An error in a number      A negative
used in a formula           number for

the root formula

##### #### The calculated result
is too long to display
in the cell

#DIV Err: 503 Division by zero is =345/0
not allowed

Window Err: 510 Variable is missing =1+*2
with
instructions
opens
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Resizing cells
Data will not always fit perfectly in the cell size that the spreadsheet
first opens with.  If you type a longer entry in a cell, like given in the
example above, it will overlap if the adjacent cells are empty.  For
instance, there was nothing entered in any other cell so the text
appears over cells B1 to G1.

A cell may be resized by adjusting the width of the column or the
height of the row using the mouse and the click and drag method.
Notice the lines that divide the column headings and row headings.

Place the cursor (do not click yet!) on this dividing line.  You will
know your mouse is in the right place because the cursor will change
to a double arrow.  Once you see this double arrow, left-click the
mouse and hold the button down.  With the mouse button held down,
drag the mouse to make the cell the desired size. You will see the
line move as you drag the divider.

In our example, you would click on the divider between columns A
and B and drag it until it is after the word cell.

Notice that all of the text is (still) in cell A1.
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Saving a spreadsheet
After you have been working for a few minutes on a document, STOP
and SAVE.  You can also set the auto-save function. This can be
found under tools/options. Go to “save” and set the number of minutes
as you work.

There are five ways to save a document.

1. Use the File Menu.

2. Use the Save button on the Standard toolbar

3. Use the Save command

4. Set the auto-save option

5. Press Cntrl and save.

1. Use the File Menu
Click on the File menu located on the Menu Bar and then click
on Save from the drop-down menu.

2. Use the Save button on the Standard Toolbar

By clicking on this button , your document will automatically be

saved.
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3. Use the Save command

There are several keyboard shortcuts that perform certain functions
in spreadsheet programmes.

Commands use the ‘Control’ key .

You will notice on the right-hand side of the file menu that there are
various commands, which appear as Ctrl + some capital letter.
Notice that the keyboard option next to Save is Ctrl+S.

In this case, if you wanted to save a file, you could press  and

keep it pressed down and with the other hand you press the ‘S’ key
once.

Any way you choose to use, you will see a pop-up window appear
on the screen. You must show the computer exactly where you want
to save the file.

STEP 1 - Save location:

The first thing to do is to ensure that you are saving the file in the
correct folder. Look at what is written in the Save in: line at the top of
the pop-up window.

... or navigate to any location

Delete the highlighted default file name and type in
your own, unique document name.

Click to navigate to these special locations ...
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The default saving location for many programmes is a folder located
on your desktop name “My Documents”.  Until you get accustomed
to finding your way around your computer, this would be a good place
to save things.  As you gain experience your may want to create
your own folders on the C: drive as a saving location for your
documents, images and any other files you create.

STEP 2 - Document name:

The first time you save you will want to give your document a new
and unique name (remember it is called Document 1 when you first
open a new blank document).  Type your chosen file name in the
File name: box at the bottom of the pop-up window.

STEP 3 – Save!:

Once you have chosen where to save your document and what its
name will be, click on the Save button .
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Save versus Save As…
If you notice in your File menu, there are options for both Save and
Save As….

You use Save the first time you save a file, where you will have to
name your file and save it in a specific location. It is recommended
that you keep saving the file every few minutes. You do not have to
name it every time since you have already given it a name. You can
save an existing file by merely clicking on the Save button.

You use the Save As command when you want to:

• change an existing file name

• change the place where the file is stored

• change the file type.

When you choose to use Save As… you will be presented with the
same pop-up screen as you would when you use Save (see above).

Again, Save early and Save often!  You never want to lose work
that you have spent much time and energy on.
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Opening a workbook
There are three ways to open a workbook.

1. Use the File menu.

2. Use the Open button on the Standard Toolbar.

3. Use the Open command.

1. Use the File menu
Click on the File menu located on the Menu Bar and then click on
Open from the drop-down menu.

2. Use the Open button on the Standard toolbar

3. Click on this button:

4. Use the Open command
Similar to the Save command, you will have to press

and keep it pressed down while you press the “O” key once with
your other hand.

Once you have done one of these three procedures, you will see
this pop-up window:

You need to navigate around to locate the document you want to
open.  Once you locate it, click on it and click on Open. Another way
is to “double-click” on the file name. The file will open automatically.
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Closing a spreadsheet
Closing a document is quite simple.  There are two Xs in the upper
right corner of your window:

Click on the smaller X  to close the specific workbook you are
working on.  Unless you have just saved your work, the programme
will prompt you with this pop-up window:

You need to navigate arount to locate the document you want to
open. Once you locate it, click on it and click on Open.

...or to navigate to any location on your
computer or external device...

Click on
icon to
navigate to
these
special
locations...

... then click here to
open the document.

Typically you will want to click on Yes, unless you have made changes
that you do not want saved, in which case you would click No.  If you
have clicked this X by mistake, which can happen, just click Cancel
and you will return to your workbook to continue working on it.
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Exiting a spreadsheet programme
Exiting the spreadsheet programme is very similar to closing a
workbook.  Remember the two Xs in the upper right corner.

This time click on the one above, the big X in the red box.

If you have not saved your work currently, this will bring up a pop-up
window asking you if you want to save changes made for each
spreadsheet you have currently open.  For instance, if you have three
different workbooks open which you have been working on, three
pop-up windows will appear asking you if you want to save changes
for each of the workbooks.

If you have not saved your workbook at all, the spreadsheet
programme will recognise this and prompt you to save.  You will be
asked if you want to save changes to ‘Book 1’, as the document has
not yet been named

If you want to save this work, click Yes and the Save pop-up window
will appear.   You proceed as per the instructions described above.

Once you say Yes or No to saving changes on an already named
spreadsheet, the spreadsheet programme will exit.

Figure 1: Microsoft Excel closing down window
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CHECK YOUR PROGRESS 1

PRODUCE A BASIC SPREADSHEET DOCUMENT

1. List 3 advantages of a spreadsheet

1.__________________________________________________

2.__________________________________________________

3.__________________________________________________

2. List 3 disadvantages of a spreadsheet

1.__________________________________________________

2.__________________________________________________

3.__________________________________________________

3. Crossword puzzle

1. 2.

3.

4.

7.

6.

9.

10.

12.

13.

5.

8.

11.

14.
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CHECK YOUR PROGRESS 1

ACROSS

1 There are automatically three of these when you open a new workbook

4 Where you can access the File menu

6. This bar is where the name of your workbook appears

7. Letters at the top of the worksheet area are headings for these

9. What you do when you want to shut down the spreadsheet

10. Toolbar located beneath the standard toolbar

12. Toolbar that contains the buttons for saving and starting a new workbook

13. Crtl+L is the command for this function

14. This bar is where you can edit a selected cell

DOWN

1. The name of spreadsheet files

2. A cell indicated by a thick black rectangle around it is this

3. These bars allow you to view parts of the worksheet that are off the screen

5. Numbers to the left of the worksheet area are headings for these

7. One method used to change the size of cell

8. Will indicate the active worksheet

11. Where the selected cell’s reference name appears only if “C” - copy of
this is provided

12. Toolbar that contains the buttons for name saving and starting a
new workbook

13. Crtl+S is the command for this function

14. This bar is where you can edit a selected cell
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PRODUCE A BASIC SPREADSHEET  DOCUMENT

1. Open a blank workbook.

2. Save the workbook as ‘Spreadsheet Activity 1’ in My Documents.

3. Enter this data:

In cell A1 First Name

In cell A2 Surname

In cell A3 Address

In cell A4 Phone number

In cell A5 Birthdate

4. Resize all the columns so that they fit the text in each by using the “auto-fit”
feature under format.

5. Go back to the cell titled ‘Address’ and add the ‘Postal’ so that  cell A3
now says ‘Postal Address’.

6. Enter at least three contacts of yours.

7. Resize the column widths again to fit all data (see 4).

8. Close the workbook (make sure you save when prompted).

9. Close the spreadsheet programme.

PRACTICAL  ACTIVITY 1
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Summary
Well done! You have completed Section 1 on Produce a basic
spreadsheet document.

You should now be confident that you understand the purpose,
advantages and disadvantages of using a spreadsheet programme.

You should also be confident that you have the knowledge and skills
to produce a basic spreadsheet document.

If you feel confident that you have achieved the above, you can move
on to the next section where you will learn how to format and edit a
workbook.

If you are unsure of any part, go back and revise it or ask your
instructor or supervisor for assistance.
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Section

2

Format and edit a
workbook
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Introduction
In this section of the manual you will learn how to format and edit a
workbook.

It includes the basic formatting features such as bold, italics,
underline and alignment, and the basic editing features such as cut,
copy, paste, undo/redo, move and insert.

In order to perform these tasks, you will also have to learn how to
select cells and sections of data/text by using both the mouse and
the keyboard.

Skills you will learn
By the end of  this section, you will be able to:

• describe the basic formatting and editing features of a basic
spreadsheet

• demonstrate the procedures to apply basic formatting features

• demonstrate the procedures to apply basic editing features.
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Formatting features
Formatting involves specifying the font, alignment, margins and other
properties of the text.  If you have used a word processing
programme before, you will find that formatting a spreadsheet works
the same way.  This all determines how the workbook will appear
on the screen and how it will look when printed.

Every spreadsheet will have a formatting toolbar, as mentioned in
Section 1, with buttons for the most frequently used formatting tools:

In most, the button icons on the formatting toolbar give you an idea
of what that button does.  If not, just hold the mouse pointer over the
button for a couple of seconds and the name of the button will appear.

As a beginner, you start by focusing on only certain formatting tools.
You should, however, always feel comfortable playing around with
other tools. You can always undo mistakes!

Character emphasis
Sometimes you want a word or phrase to stand out, by making it

bold or italic or by adding underlining.  

As with word processing, you can apply this direct formatting when
you are typing the text, or later, as you edit.  You can even add more
than one emphasis button to combine the emphases – bold italic,
for example, or underlined italic, and yes, even underlined bold
italic!

Button on Function of emphasis button What the
Formatting emphasis will
 toolbar look like

Turns boldface character Emphasis on will

emphasis on or off. look like this.

Turns italic character Emphasis on will

emphasis on or off. look like this.

Turns character underlining Emphasis on will

on or off. look like this.
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Add emphasis as enter data
1. Select a cell.

2. Click an emphasis button.

Notice that when an emphasis button is on, the button will be a yellow

color .

3. Type your emphasised text.

4. Click the emphasis button again to turn off the emphasis.

When you turn off the button, it will appear blue again

.

Add emphasis after data is entered

1. Select the cell you want to emphasize.

2. Click an emphasis button .

3. Click another emphasis button if you want to use more than

one .

2. Click emphasis button

4. Click to
turn off
emphasis

1. Select a cell

3. Type word with emphasis
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Remove the emphasis
1. Select the cell with emphasis.

2. Click button (will be yellow if on) to turn off any pressed emphasis
button (button will now be blue).

Alignment
The alignment controls how the lines of text are arranged relative to
the edges of the cell.  This means the vertical and horizontal
positioning of the text or data within a cell.  There are three different
options for text alignment.    Again, the button that is in
yellow is the selected alignment for the text being typed or formatted.

Button on  Function of particular Typical purpose
Formatting   alignment
toolbar

Left-aligns the current Align left is the

text or paragraph. default alignment for text.

 Centre-aligns the

current text or
paragraph.

Right-aligns the current Align right is the default

text or paragraph. alignment for numbers.

Changing the alignment of any cell is very simple.

1. Select the cell of which you want to change the alignment.

2. Click an alignment button.
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Formatting multiple cells
To select certain cells, you must select all of them by highlighting.
The term highlighting refers to the change in colour or shade when
cell is selected.

For instance, there are 12 cells highlighted in this figure.

You can highlight cells in two ways (you can choose the easiest for
you):

• Click and drag the mouse pointer over the cells you want to
select.  (To use the ‘click and drag’ method, hold the left mouse
button down while you drag the mouse over the cells you want to
format.)

• Click on the first cell.  Then use Shift and cursor arrow keys
together to select cells.

To deselect a range of cells, simply left-click once on any non-
selected cell and the selection will disappear.

To format an entire column or an entire row, click on the column or
row heading to select the whole column or row.  Like when resizing
a cell, the cursor will look different when you should click.  It will look
like a small black arrow.       When the entire column/row is selected,
it will be filled in blue.
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Example:  All of column A is selected.

Example:  All of row 1 is selected.

Selecting non-adjacent cells, rows or columns is also possible.  To
do this, hold down the Ctrl key on the keyboard and then click on the
desired cells, columns or rows with the cursor.

Once highlighted, click on the format buttons that you want.
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Editing features
Editing data is an essential function of a spreadsheet.  Whether you
are creating an address book, a financial report, or a mark sheet, it
is almost certain that you are going to need to make some changes.
A spreadsheet provides a variety of ways to edit.  To edit existing
content, you simply select the cell and make your changes.

There is a whole menu devoted to editing called Edit in the Menu
bar.

As with the File menu discussed in Section 1, you will notice icons
next to the functions that correspond with buttons on the Standard
toolbar.
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For this manual, we will concentrate on five editing tools.

Button on Name of button Purpose
Formatting
toolbar

Cut Cuts the selection from a cell or cells.

Can be used to paste (inserted )somewhere
else in the spreadsheet.

Copy Copies the selection.  Can be pasted

(inserted) somewhere else in the spreadsheet.

Paste Pastes (inserts) the contents cut or

copied to location you specify.

  Undo Undoes the last action.  The down arrow

displays a series of actions that can be
undone or restored.

You can also select multiple cells, as just described, and change
them all at once.

Many times when you are creating a workbook you will want to move
cells, copy cells and even cut cells.

Moving Cells
1. Select the cell or highlight the cells to be moved.

2. Click the Cut button.

When you Cut, a blinking box will outline the selection.

3. Click in the cell where you want to move the selected/highlight
cell(s) to.

  Redo Redoes the last action that was undone

using the Undo button.  The down arrow
displays a series of actions that can be
restored.
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4. Click the Paste button .

Copying Cells
Use Copy when you want the original cells to stay in its current
location.

1. Select a cell or highlight cells.

2. Click the Copy button .

3. Click the cell(s) where you want to copy the selected cell(s) to.

4. Click the Paste button .
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Undoing and Redoing
A terrific feature about spreadsheet is that you can quickly undo
mistakes.

Undo one mistake
As soon as you realize the mistake, click the Undo button

to restore the workbook to its original state.

Undo several mistakes
When you know that you have made several mistakes, you can:

• keep clicking the Undo button until you have returned the
workbook to its original state

• click the down arrow at the right of the Undo button to see a list of
actions that you can undo.  Click on the last editing you want to
undo and everything from that point will also be undone.

Redo and Undo
Spreadsheets also allow you to change your mind.  When you have
undone one or more mistakes and then decide they were not
mistakes at all, you can restore them with the Redo button.  It works
exactly like the Undo button – just think of it as the Undo Undo button

.

Insert
Another menu that drops down from your menu bar is Insert.
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All of these options are tools for inserting something into your
spreadsheet, whether it is another row, worksheet or chart.

If you want to insert a row, first click on the row below the inserting
point.  For instance, if you want to insert a row above Row 2, click on
Row 2.  Then go to the Insert menu and click on Row.  If you want to
insert a column, click on the Insert menu, then Column.  A column
will then be inserted to the left.

If you just want to insert a single cell, right-click on a cell and click on
Insert.

You will see this window

You can choose from this pop-up window whether you want to insert
a cell above (Shift cells down) or insert a cell to the right (Shift
cells right).  You can also insert a row (Entire row) or a column
(Entire column).

Of course, if you make a mistake and insert a cell or column in the
wrong place, you can always Undo.

Figure 2: Insert menu on microsoft excel
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CHECK YOUR PROGRESS 2

FORMAT AND EDIT A WORKBOOK

1. What are the three  emphasis features mentioned?  Sketch each button
that adds this emphasis next to your answer.

1. _____________________________________________________

2. _____________________________________________________

3. _____________________________________________________

2. List the 4 steps that move cells to another spot in the workbook?

1. _____________________________________________________

2.____________________________________________________

3.____________________________________________________

4.____________________________________________________

3. Identify the alignment:

1. _____________________________________________________

2.____________________________________________________

3.____________________________________________________

4. What is another name for Redo? Why?

______________________________________________________

______________________________________________________

______________________________________________________

1.

2.

3.
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FORMAT AND EDIT A WORKBOOK

1. Open ‘Spreadsheet Activity 1’.

2. Select Row 1 and add bold emphasis.

3. Highlight all your data – should be 20 cells.

4. Cut these cells and paste them on Sheet 2.

5. Resize the column widths so that all data can be seen.

6. Make all the heading in Row 1 centre aligned.

7. Save changes.

8. Close programme.

PRACTICAL  ACTIVITY 2
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Summary
Well done! You have completed Section 2 on Format and edit a
workbook.

You should now be confident that you know what the terms ‘bold’,
‘italics’ and ‘underline’ mean, and how to format your workbook by
using different alignments.

You should now also be able to manipulate and move around text in
your workbook by using the editing features such as cut, copy, paste,
redo/undo, move and insert.

If you feel confident that you have achieved all the above, you can
move on to the next section, where you will learn how to apply simple
spreadsheet calculations.

If you are unsure of any part, go back and revise it or ask your
instructor or supervisor for assistance.
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Section

3

Basic spreadsheet
calculations
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Introduction
In this section of the training manual you will learn how to do simple
calculations such as addition, subtraction, division and multiplication
on a spreadsheet document.

Skills you will learn:
By the end of  this section, you will be able to:

• describe the procedures to perform basic spreadsheet
calculations

• apply the procedures to perform basic spreadsheet calculations.
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Basic spreadsheet calculations
There are numerous calculations and formulas that a spreadsheet
can perform.  In this section you will only learn a few of the basic
ones to get you started.

Entering Formula:
Place the cursor in the cell in which you want the answer (result of
the formula) to appear.  All formulas start with an = sign.  This tells
the spreadsheet this cell will ‘equal’ some formula that you are
entering.  Type in your formula; it will appear in the formula bar.   Press
Enter once you have typed the formula and the answer should appear.

When dealing with formula, you should refer to the cell address
instead of the value in the cell e.g. =A1+C1 instead of 45+57.

Notice when you press Enter, the answer will appear.  However, if
you look in the formula bar, it still shows the formula.  This means
that cell E1 is told to calculate the total of cell A1 and cell C1.  If you
change a value in one of these cells, the answer will change
accordingly.

 + means add e.g. A1+C1 adds the value (number) in A1 to the value
(number) in C1

- means subtract e.g. A1-C1 subtracts the value (number) in C1 from
the value (number) in A1

* means multiply e.g. A1*4 multiplies the value (number) in A1 by 4

/ means divide e.g. A1/3 divides the value (number) in A1 by 3
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Use BODMAS if you are using multiple operators such as brackets
first, then division, multiplication, addition and subtraction

e.g. = ((A2-B2)*3)-100 

Notice that individual sums within a sum are bracketed and appear
at the beginning of the formula. 

TRUE/FALSE Statements

You can also create formulas where the value is a logical statement
– True or False.  This is used when calculating greater than or less
than formulas.

> means greater e.g. A1>C1 Determines if the value (number) in A1
than is greater than the value (number) in C1.

Answer will be TRUE or FALSE.

>= means greater e.g. A1>=C1 Determines if the value (number) in A1
than or equal to is greater than or equal to the value

(number) in C1.  Answer will be TRUE
or FALSE.

< means less than e.g. A1<C1 Determines if the value (number) in A1
is less than the value (number) in C1.
Answer will be TRUE or FALSE.

<= means less e.g. A1<=C1 Determines if the value (number) in A1
than or equal to is less than or equal to the value

(number) in C1.  Answer will be TRUE
or FALSE.

= means equal to e.g. A1=C1 Determines if the value (number) in A1
is equal to the value (number) in C1.
Answer will be TRUE or FALSE.

Example 1

Since the value (number) in cell A1 (45) is not greater than the value
(number) in cell C1 (57) the answer (shown in cell E1) is FALSE.

Example 2
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Since the value (number)in cell A1 (45) is less than or equal to the
value (number) incell C1 (57) the answer (shown in cell F1) is TRUE.

Example 3

Since the value (number)in cell A3 (45) is equal to the value
(number)in cell B3 (45) the answer (shown in cell C3) is TRUE.
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CHECK YOUR PROGRESS 3

BASIC SPREADSHEET CALCULATIONS

Write the formula that you would enter into the formula bar to calculate:

1. C3 plus C4 minus C5_______________________________________

______________________________________________________

2. C4 divided by G4 __________________________________________

______________________________________________________

3. Is H1 less than H2? ________________________________________

______________________________________________________

4. The sum of D6 and D7 multiplied by E8 __________________________

______________________________________________________

5. Is F4 greater than or equal to J6? ______________________________

______________________________________________________

6. Is F4 equal to F6? _________________________________________

______________________________________________________

7. The product of G5 and G6 divided by G7 _________________________

______________________________________________________
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BASIC SPREADSHEET CALCULATIONS

1. Open a  ‘Spreadsheet Activity 1’.

2. Select Sheet 3 for this activity.

3. In cell A1, type ‘=345+5877’.  What result do you get?  Where do
you find it?

4. In cell B1, type ‘=A1-300’.  What result do you find in B1?

5. In cell C1, type ‘=(B1*7)+3’.  What result do you find in C1?

6. Select cell B1 and replace the number ‘300’ with ‘10’.  What result
do you find in cell C1?

7. Select cell A1 and replace the number ‘345’ with ‘20’.  What results
do you find in cells B1 and C1?

8. In cell D1, type ‘=A1>B1’.  What result do you get?

9. In cell E1, type ‘=C1<B1’.  What result do you get?

10. Close the workbook and programme.

PRACTICAL  ACTIVITY 3
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Summary
Well done! You have completed Section 3 on Basic Spreadsheet
Calculations.

You should now be confident that you know and understand the
procedures to perform simple arithmetic calculations in a
spreadsheet document.

If you feel confident that you have achieved the above, you can move
on to the next section, where you will learn how  to use the Help
function in a spreadsheet document.

If you are unsure about anything, go back and revise or ask your
instructor or supervisor for assistance.
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Section

4

Use the Help function
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Introduction
In this section of the training manual you will learn about the
procedures to use the Help function when producing a spreadsheet
document.

This will cover how to search for topics and use the hyperlinks to
move around the tool.

Skills you will learn
By the end of  this section, you will be able to:

• state the purpose of the Help function

• describe the procedure for using the Help function

• apply the procedure for using the Help function.
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Spreadsheet Help functions
Purpose of the Help function
Most computer programmes have a Help function, which provides
a quick way to find out how to do a particular task.  If you are uncertain
how to do something in spreadsheet, the Help function is there to
guide you, step-by-step, on how to perform that task.

The advantage of the Help function is that it is a resource that requires
nothing but your computer.  The Help function also often uses
hypertext, which means you can click on a link to read a new, related
Help topic.

Use the Help function
There are three ways to access the Help function:

a) use the Help menu located in the menu bar.

b) click on the button in the standard toolbar.

c) press F1.

1. Using the Help menu located in the menu bar.

Click on Help in the menu bar and this drop-down menu will appear.

Click on  Microsoft Excel Help, or the equivalent, to open the Help
function.

2. Clicking on the button in the standard toolbar.
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Click on this button

to bring up the spreadsheet Help function.

3. Pressing F1.

You can also press the F1 key in the function keypad at the top of
your keyboard to bring up the Help function.

In whatever way you access the Help function, this dialog box will
come up on the right-hand side of the screen.

Click here to get a Table of Contents for
all the help provided for spread-sheets.
The window below will appear:

Type the word or phrase for the task you
need assistance for in the box under
Search for:... Once you type the word
or phrase to search for, press the Enter
key and the function will produce the
search results.
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Example:

Perhaps you want information about printing worksheets.  You might
type this:

Once you press the Enter key or the green arrow , this Search

Results window will be produced.  Scan the results in blue text.
These are the hyperlinks.  Use the scrollbar on the right side to see
all the search results.  Click on any link that describes a task that
you would like to know how to perform.

The great thing about the Help function
is that you can read the directions and
try it on your worksheet at the same time.

Example continued:

Let us say you really want to know how
to print your sheet with a border or
gridlines. Scan the hyperlinks and you
will notice Print with or without cell
gridlines. You will then get the following
directions on how to do it.
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When you are completely finished with the Help function, click on
the

in the upper right corner of the Help box, to close the box.  You can
then continue working on your worksheet.

Once you are finished with that specific help, click on the

in the upper right corner of the help box to close.

You can then click on a different hyperlink.  If you want to do a new
search, use the search box at the bottom of the Help box.
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CHECK YOUR PROGRESS 4

USE THE HELP FUNCTION

1. What is the purpose of the Help function?

______________________________________________________

______________________________________________________

______________________________________________________

______________________________________________________

2. Which one of the following is  NOT a way to access the Help function:

a). Click on . __________________________________________

b). Use the Tools menu in the menu bar. _________________________

c). Press F1.  _____________________________________________

d). Use the Help menu in the menu bar. __________________________
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USE THE HELP FUNCTION

1. Open ‘Spreadsheet Activity 1’.

2. Access the Help function.

3. Search for ‘currency’.

4. Find the hyperlink for ‘Add or remove currency symbol’.

5. How would you add the default currency symbol?

6. Add currency symbol to your figures.

7. Close your programme with changes saved.

PRACTICAL  ACTIVITY 4
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Summary
Well done! You have completed Section 4 on Use the Help function.

You should now be confident that you have the knowledge and skills
to use the Help function on your computer when you are producing a
basic spreadsheet.

If you feel confident that you have achieved the above, you can move
on to the next section where you will learn how to print a basic
spreadsheet’.

If you are unsure about anything, go back and revise or ask your
instructor or supervisor for assistance.



65

Produce basic spreadsheets

Computing fundamentals
© Namibia Training Authority - 2006



66

Produce basic spreadsheets

Computing fundamentals
© Namibia Training Authority - 2006

Section

5

Print a basic
spreadsheet document
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Introduction
In this section of the training manual you will learn the procedures to
print a basic spreadsheet document.

You will also learn the different printing features, such as the page
setup, number of copies, page range and the printing properties .

You will be taught how to preview your document before you print to
make sure that the layout is to your liking.  As such, you will also
learn how to set the page orientation, send the document to different
printers and modify page margins before printing

Skills you will learn
By the end of  this section, you will be able to:

• describe the different printing features

• describe the procedures for printing a basic spreadsheet

• apply the procedures for printing a basic spreadsheet.
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Purpose of printing features
Printing a worksheet or an entire workbook is one the main functions
of a spreadsheet.  This is the most common ways to distribute a
finished worksheet or workbook.  The ability to print your work makes
spreadsheet efficient and useful for professional and personal use.

Because this is such a crucial function, there are several printing
features that a spreadsheet offers to users.

Before you print

There are two things you will want to do before printing your
spreadsheet.

Page Setup
The first thing to do before printing is to go to Page Setup.  Page
Setup will let you change and set numerous features your worksheet
and/or workbook.  To access Page Setup, click on File menu and
find Page Setup.  If you do not see Page Setup immediately, click
on the chevron to see the entire File menu.

This pop-up window will appear.
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There are three tabs at the top of this window: Page, Margins,
Header/Footer and Sheet.  Each tab give allows you to modify
various features of your workbook or sheet that will affect the way it
looks when printed.

The first tab in this dialog box is Page.

Orientation:  This refers to how your document lies on the page –

vertical (Portrait ) or horizontal (Landscape ).

Click on the one you want.  Often worksheets are printed in
Landscape to fit more cells on one page.

Scaling:  This portion of the box allows you to adjust the scale at
which you want your worksheet(s) to be printed.  For example, you
can choose your sheet to be printed at 50% the original size.  You
can also force the entire work to be printed in one or any number of
pages by choosing the Fit option.  For instance, if you choose two
pages wide by two pages tall, the maximum number of pages that
your work will be printed on is four.

Paper Size:  In Namibia, we use A4 paper.  In other places, people
use paper which is called “letter”.  It is very important that you set
your computer to the correct paper size before you start to print.
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Now click on the Margins tab and you will see this

Margins refer to the blank spaces to the left and right sides and the
top and bottom of a sheet when it is printed.  The size of the margin
can be increased or decreased.  Sometimes you may need to play
around with the margins to ensure that your printed results are properly
centered.

At the bottom of the box where it says Centre on page, you can
select to center your sheet Horizontally or Vertically.  Simply click
in one or both boxes to do so.

Now click on the Headers/Footers tab.

If you think of your printed page as a human body, then the terms
header and footer make perfect sense.  The header is one or more
lines of text that appear at the top of every page printed in a workbook.
The footer consists of one or more lines of text that appear at the
bottom of every page printed in a workbook.
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Click on the down arrow for a header or footer and choose any one
of the options available.  Here you can add page numbers, name of
your workbook and other information.  You can also create your own
custom header or footer by clicking on Custom Header or Custom
Footer and following the instructions.

Lastly, click on the Sheet tab.

This tab allows you to specify other features on actual sheets to be
printed.  For instance, Print area allows you to choose a specific
area of the sheet to be printed (instead of the entire sheet).  Print
titles allow you to choose specific rows or columns that can be
printed at every page.

Under the Print section of the dialog box, you can select any of the
options by clicking in the box next to the title.  Selecting Gridlines
will print the worksheet with the gridlines of the entire worksheet.
Selecting Row and column headings will print your sheet with these
headings on the left and top accordingly.

For now, do not worry about other features in these different tabs.
However, if you are curious about them, you can always use the
Help function to learn more about each feature, what it does and
how to use it.

To close this window, no matter which tab you are on, click OK.  If
you do not want to save changes made to features in this Page
Setup dialog box, you can click Cancel.
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Procedures to apply printing
features

With a spreadsheet you do not always print the whole spreadsheet
as you would in a word processor, for instance. You will quite often
first select a part of a workbook and then choose to print that selected
part. Furthermore, since a spreadsheet’s workbook is an electronic
sheet which is much bigger than an A4 piece of paper (as found in a
printer), it is always advisable to first preview your print result before
choosing to print the selection.

In Page Setup you will notice a button to the right side that says
Print Preview.

You can select Print Preview here, or you can access it two other
ways.

You go to File menu and click Print Preview or click the
corresponding button on the Standard toolbar .

Which ever way you access the Print Preview you will get a smaller
view of your speadsheet to see what it will look like when you print it.

If the selected text appears on the preview screen and you are

satisfied with the previewed result, click on the Print button 

on the toolbar on top
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However, sometimes extra columns you have entered data on do
not appear on the page. There are several options for changing the
page before printing:

• change the margins

• change the page orientation (portrait to landscape)

• reduce the column widths

• decrease the font size of data

To change the margin widths:

On the Print Preview page, click on the Margins button

and move the mouse pointer  to the dotted lines representing the

margins that you want to change. A double arrow    appears
(circled in the image below). Press the left mouse button and keep
it down. Drag the margin to the width you want.

To change the page orientation:

Click on the Setup button

,

or choose Page Setup from the File menu.

There are other ways to print a spreadsheet than through Print
Preview.
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1. Use the File menu and click on Print.

2. Press Ctrl+P.

Either way will bring up this pop-up window

Properties
There are tabs, similar to the Page Setup dialog box, in the
Properties dialog box.  Click through the tabs to see the features
that can be set or changed.  Many are similar to those found in
other places.

You can either set/change them here or just ensure features are set
to you preferences.

To close the Properties dialog box, click on OK to save changes
made or Cancel to disregard changes.

Click here to select
another printer.

Click here to
get the
Properties
dialog box
(see below)

Click here to
specify the
number of
copies to be
printed.

Click here to finish
and send to printer

Print range
defines the
range of pages
to be printed.

Print what defines
what portion of
your worksheet to
print or to print the
entire workbook.
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Print Range
The spreadsheet will assume you want to print all pages  in

the worksheet,, unless you specify otherwise.  You see exactly what

each print page will look like by clicking on Preview  (same
as Print Preview).  If you only want to print a certain range of pages,
enter these numbers in the spaces provided

Print What
As the spreadsheet assumes you only want to print the active sheet

, and you want all sheets in the workbook printed, you

must select this option .  Click in the circle to select.  In

addition, you can also print just a portion of a sheet.  You must highlight
the desired portion in your worksheet area then click Selection when
printing .

Copies
You can either type in the number of copies you want or use the

arrows  to increase/decrease number of copes.  The Collate box

 also indicates that if you print more than one copy, the copies
will be printed as a set each time.  For instance, if you are printing
four copies of three pages, (Pages 1, 2 and 3), these will print in
that order four times.

If you ‘uncheck’ the Collate box, Page 1 will print four times, then
Page 2 will print four times, and then Page 3 will print four times.

Press OK  when you have set all the print features to you

liking.  This will send the worksheet or workbook to the printer.

Press Cancel if you decide not to print.

There is one more way to print your spreadsheet, but not
recommended.  You could use corresponding button on the Standard

toolbar .

However, remember that this will automatically send the all pages of
the entire active worksheet to your default printer.  The default printer
is the printer selected for all printing (unless otherwise told by
changing the printer Name:).  If this is not the printer you want to
send the printing job to, you must use one of the other ways to print
and select another printer.
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CHECK YOUR PROGRESS 5

PRINT A BASIC SPREADSHEET DOCUMENT

1. Label what each of these features does:

1. 2.

3.

6.

8.

7.

 5.

9.

10.

 4.
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2. Multiple choice (Tick the correct answer)

1.  How would you set the page orientation?

(a) change the margins

(b) scale pages to fit

(c) go to page setup

(d) choose a different printer

2.  What is a header?

(a) one or more lines of text that appear at the bottom of every printed
workbook page

(b)  the top of your workbook

(c) where the name of your workbook appears

(d) one or more lines of text that appear at the top of every printed
workbook page

3. Which one is NOT a way to print a workbook?

(a) Click on this button 

(b) Ctrl + P

(c) click print from File menu

(d) Click print when in Page Setup

4. What option would you NOT consider using to have more columns appear
on a printout?

(a)  change the page orientation

(b)  increase the font size

(c)  reduce the column widths

(d)  change the margins

CHECK YOUR PROGRESS 5
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PRACTICAL  ACTIVITY 5

PRINT A BASIC SPREADSHEET DOCUMENT

1. Open ‘Spreadsheet Activity 1’.

2. Change the page orientation to Landscape.

3. Insert gridlines to this selection.

4. Print the entire workbook sheet  with data on them.  How many pages is
this?

5. Get your printout.
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Summary
Well done! You have completed Section 5 on Produce basic
spreadsheets.

You should now be confident that you have the knowledge and skills
to produce, format, edit and print a basic spreadsheet document.

If you feel confident that you have achieved all of the above,
congratulations - you have successfully completed the module
Produce basic spreadsheets.

If you are unsure about anything, go back and revise or ask your
instructor or supervisor for assistance.
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Glossary
Active sheet : The worksheet that is white and appears to

be ‘on top’.  If a worksheet is active, you can
enter data, make changes, etc.

Alignment : Alignment is the way lines of text are arranged
relative to the edges of a block of text.

Cell : The intersection of a column and a row.

Cell reference : The name of the column heading and the
name of the row heading of the cell, e.g. C5.

Click : Refers to pressing either of the buttons on
a mouse

Column heading : The letters along the top of the worksheet.

Cursor : A symbol on the screen that indicates the
active position or insertion point (see
below).  The cursor can change its shape
considerably depending on where it is
standing; for instance, pointer versus
vertical blinking line.

Enter key : A large key which is located at towards
the right  centre of the keyboard.  It usually
has a little arrow ¿ on it.  Pressing this
key moves the cursor to the next line.

Format : The act of changing the properties of text
or other objects, such as colour, size and
position.  The format can also refer to the
layout of a spreasheet. The format
determines how the spreasheet will
appear on the screen and how it will look
when printed.

Formula bar : To the right of the name box, where text
and formulas are entered and edited for
each cell.

Highlight : The change of colour or shade when text
is selected.

Hypertext : Generally, any text that contains links to other
documents usually it is a word or phrase in
the document that can be chosen or clicked
on by a reader and which cause another
document to be retrieved and displayed.
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Icon : Small images which can represent functions
or  commands, and which are typically used
as buttons which activate the given command

Insertion point : This is a screen cursor which shows you
where your text will be inserted when you type.

Margins : Margins are the blank space to the left and
right sides and at the top and bottom of a
page.

Menu : Most software programs feature menus
(typically at the top of the screen), which offer
a wide range of actions and operations
available to the user, such as Save, Edit, Print
etc

Name box : A white box in the upper left corner where
the selected cells reference appears.

Row heading : The number along the left of the worksheet.

Select : The mouse can be used to choose a large
range of items for further work, including single
letters or words, one or multiple cells, columns
or rows.

Selected cell : Indicates the cell that data will be entered in.
Outlined by a thick, black rectangle.

Space bar : Long key at the bottom of the keyboard.  If
pressed, it enters an empty space “ “.

Spreadsheet : A programme that organizes and keeps track
of data and is generally used for numeric
calculations.

Workbook : Name of a spreadsheet file.

Worksheet : One grid of rows and columns in a workbook
to enter and analyse data. There are by
default three worksheets in one workbook.

Tab : Tab is a key on the keyboard that moves the
cursor to the right a prescribed number of
spaces.  The number of spaces depends on
the tab stops which can be set by the user.
Tab allows the user to move to cursor to the
next cell.
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Toolbar : Most software applications feature a series
of words and icons (typically at the top of the
screen) which show and provide  shortcuts to
commonly-used functions which are available
to the user.

Write down additional words that you do not understand.
Ask your instructor to explain the meaning of those words.
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Answers to check your progress

Check your progress 1

1 Advantages (any three):

• Saves time!  The spreadsheet instantaneously performs
mathematical calculations when set up.  No more double and
triple-checking calculations with a calculator.

• It is easy to change the data and get new results.  The
spreadsheet instantly recalculates the equation for you when you
enter new numbers

• It is easy to make graphical representations of your data.  In
addition, you can present this information in different ways and
easily manipulate from the data entered into the spreadsheet.

• Allows for flexible presentation.  You can alter column widths
and row heights, and easily delete or add cells, columns and
rows.  You can also control the types of numbers you enter – for
example, you can choose percentages, currency or set the
number of decimal places.

2. Disadvantages (any three):

• Formulas can be tricky.  Users must be very careful when they
enter equations or use formula to ensure that the spreadsheet
is calculating the intended numbers and correctly.

• It is not as text-friendly as word processing.  Text can be entered
(and lists even sorted alphabetically), but it is not good for
entering lengthy text, like a letter.

• The worksheet can become awkward.  As more and more data
is entered, the worksheet expands off screen so that not all data
can be viewed at once.  This can cause beginners problems
with finding information and navigating around their worksheet.

• Unless you have your own computer or 24-hour access to one,
you will only be able to work at limited times when you get access.
This could also cost money if you are using, for example, an
Internet café

·• You will have to take time to learn how to use the spreadsheet.
For instance, sorting and filtering data are useful functions, but
they take time to learn and perfect.

• The storage device on which you save your work can be lost,
damaged or stolen.

• Printing will require a printer
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3. Crossword puzzle

Check Your Progress 2
1. The three emphasis features are:

a. bold  

b. italics 

c. underline  

2. Steps that move cells to another spot in the workbook are:

1. Select the cell(s) to be moved

2. Select Cut

3. Click in the cell(s) to move the cells to

4. Select Paste

1. 2.

3.

4.

7.

6.

9.

10.

12.

13.

5.

8.

11.

14.

W O R K S H E E T

M E N U B A R

T I T L E

C O L U M N S

C L O S E

F O R M A T T I N G

S T A N D A R D

S A V E

F O R M U L A

O

R

K

B

O

O

K

E

L

C

E

D

S

C

O

L

R

O

W

L

 I

K

N

D

R

G

N

A

M

E

B

X

W

O

R

K

S

H

E

E

T

T

B
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1. Cell one is aligned centre

2. Cell 2 is left aligned

3. Cell 3 is right aligned

4. Another name for Redo is:

Undo undo.  It can be called this because Redo reverses
what was just done by Undo.  Therefore, it is ‘undoing’ the
function of Undo.

Check Your Progress 3
1. C3 pkus C4 minus C5 = C3+C4-C5

2. C4 divided by G4 = C4/G4

3. Is H1 less than H2? = H1<H2

4. The sum of D6 and D7 multiplied by E8 = (D6+D7)*E8

5. Is F4 greater than or equal to J6? = F4>=J6

6. Is F4 equal to F6? = F4=F6

7. The product of G5 and G6 divided by G7 = (I5*I6)/I7

Check Your Progress 4
1. The purpose of the Help function is to provide a quick way to

find out how to perform a particular task.  If you are uncertain
how to do something in spreadsheet, the Help function is there
to guide you, step-by-step, on how to perform that task.

2. Using the Tools menu in the menu bar is not a way to access
the Help function.

3. Identifying alignment:

1.

2.

3.
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Check Your Progress 5
1.1 The features of print:

1. Prints all pages in a worksheet

2. Will bring up the Properties dialog box

3. Increases or decrease the number of copies

4. Allows to change printer

5. Prints a range of pages in a worksheet

6. Collates pages if checked; if unchecked, will not

7. Prints the entire workbook

8. Send the worksheet/workbook to the printer

9. Prints a selection highlighted by user

10. Prints only the active worksheet

Question 2:

1 To set the page orientation: (c) - go to page setup.

2. A header is (d) - one or more lines of text that appear at the
top of every printed workbook page

3. (a) is not a way to print a workbook.

4. (b) is an option not to consider using to have more columns
appear on a printout.


